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Tutorial Five:

Progressive 
Print Quality 
Losses that 
Occur as an 
Inkjet Cartridge 
Becomes 
Exhausted 
Through Use
  

For this project we will be analyzing the same image (i-Star target) printed 
a large number of successive times on a Lexmark Z816 inkjet printer.  The 
aim of the project is to see how the print quality changes as the ink in the 
printer cartridge is exhausted through use.  The targets were printed with the 
Lexmark 31/33 inks on a typical plain paper, using printer managed colors 
(perceptual rendering).  The printer settings were as follows:

Photo Quality, Plain Paper, Auto-Sharpening:-off.
The spectral data for this test can be found in the Examples folder.
Now, let us begin this project.

Start i-Star

Click on the WIR i-Star executable file. For your convenience we recom-
mend creating a shortcut to the application on the desktop. When activated, 
you should see the following window:

Fig. 1

Create a new project.

Press CTRL+n or choose “New Project” in the “Project” menu and you 
will be asked for a reference measurement. This measurement represents the 
original state of the image to be analyzed and in this case it will be the first 
print made with a brand-new cartridge.

Select Lexmark_Page01.xls in the open file dialog and click Open.
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Fig. 2

Fig. 3

i-Star will then process the file.  Please be patient as this process may take 
some time due to the large number of calculations that need to be performed.  
Note that it gives a warning that some information needs to be specified.

This means that the data collecting software for the measuring device did 
not report the number of columns and rows in its output file. Fill out the 
“Number of Rows” and “Number of Columns” fields in the dialog box shown 
below. The target from which this data originated has 25 rows and 32 col-
umns.

Fig. 4
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Fig. 5

Enter the number of rows and columns in the appropriate fields.
Press the “Proceed” button

i-Star will now interpret the data contained in the file and evaluate the 
parameters for all the predefined regions of interest. Unless this warning is 
disabled in the preferences, you will receive a message to check (and possibly 
reassign) the color map values of the target.

The default values can be changed on the “Project Color Map” tab of the 
“Preferences” page.

Press F2 or choose “Preferences” in the i-Star menu.
Navigate to the “Project Color Map” tab.

Now you should see the screen shown on Fig. 6.
In order to perform the necessary calculations, i-Star needs to have values 

for the lightest and darkest (Lmax and Lmin) patches on the target.  In an ideal 
situation using an ideal paper (extremely white paper) and an ideal ink set (an 
ink set capable of producing extremely dark tones i.e. pure black) the values 
of Lmin and Lmax would be 0 and 100 respectively if the target contains pure 
white and pure black patches.  Since this situation is almost never the case, the 
user has to decide how he wants i-Star to handle the tonal scale of the target.  

The first option, “Defined by user,” allows you to artificially set these val-
ues to what you consider to be reasonable for the test. 

“Defined by image” on the other hand analyzes the image and selects the 
highest and lowest L values.

“Defined by map” takes a given percentage of patches with the lowest/
highest L values and calculates the average.  The percentage of patches used 
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Fig. 6

in the calculation is set in the text box that is after the ‘Mark Extreme’ button.  
For this example, use a value of 1%.  This means that for this test we will let 
Lmax be the average L value of the brightest 1% of the patches on our tar-
get.  Lmin will be the average value of the darkest 1% of the patches on our 
target.

Choose “Defined by map” for both the black and white patches.
Click the “Mark Extreme” button for a value of 1%.
Apply the changes.

The i-Star target offers a broad selection of hues and tones to study, as well 
as  tools to isolate custom regions of the color space for further evaluation. 
For this test the main regions we are interested in are the complete set of data, 
the neutrals, and the near neutrals. Additionally we will evaluate the differ-
ences between the Lmin and Lmax patches. Many of these regions are already 
mathematically defined within the application, but redefining them spatially 
can be useful and this feature is supported by i-Star as well.

Navigate to the “Project Crops” tab.

The “Project Crops” function allows you to spatially create your own re-
gion of interest when analyzing a target.  The chart on the following page 
shows which patches are contained in each of the regions we’re trying to cre-
ate. We will create a custom crop for skin tones, near-neutrals and neutrals, 
followed by the groups for Lmin and Lmax patches.
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Fig. 7

First we will create a region for the skin tones. The skin tones are located 
in the last four columns of the target. Double-click on any of those cells. They 
will be marked by an “X”. All the patches marked with an “X” will be in-
cluded in the region. You can also select the entire region you wish to include 
in this custom crop, and click on the “Mark selected” button.

Select the last four rows of the target.
Click the “Mark selected” button.

Fig. 8 Fig. 9

Now that you have all the necessary patches 
marked, you need to save them as a region of 
interest - or in this case, a custom crop. “Custom 
crops” are a special form of regions of interest 
that have been spatially defined and are target 
dependent, whereas the term regions of interest 
mainly refers to numerically defined regions in 
the test target.
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Click the Add button.
Enter “cc_skintones” in the box.

To complete the process continue with the remaining three groups of patch-
es from the target and name them “cc_neutrals,” “cc_lmax,“ and “cc_lmin.” 
Now you have all four new custom crops that will be further discussed de-
fined.

Fig. 10

The rest of the files in the project have the 
same geometry as the initial file, so we can 
safely activate the DIA (Data Import Assump-
tions) engine.  The DIA engine makes assump-
tions about the size and measurement param-
eters of the targets, based on the reference file 
for each of the I-Star projects.  Consequently, 
before employing the DIA, it is imperative that 
you verify the the data for each of the mea-
surements in the project is comparable.  This 
may not be the case if some of the measure-
ments were performed by different measuring 
devices or software.  The check boxes in the 
“Data import options” section will assist you 
in verifying that your data meets the neces-
sary criteria for an accurate comparison.

Navigate to the “Data import options” sub-tab on the “General” tab.

Fig. 11
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Activate all the assumptions, and make sure the selected sequence of 
patches is left-to-right.

Deactivate the “Import only user confirmed data” option.

Leaving the “Import only user confirmed data” option on allows for addi-
tional user modification from the “Data Layout” page after the completion of 
the DIA engine’s cycle.  Now let’s return to the “Project Description” page.

Press F2 or choose “Preferences” in the i-Star menu.

i-Star calculates the results based on the parameters set on the “Prefer-
ences” page, and so you must recalculate the values of the i-Star components 
after any data-related parameter changes are made. Since we recently modi-
fied the color map for the project, it is necessary to recalculate the averaged 
data for the project. 

 
Press F7 or select “Recalculate Project” in the “Project” menu.

Fig. 12

Fig. 13

Note that the process may take several moments to complete. Once the 
recalculation is completed you will be notified via a message box.

We will now import the rest of the files for the project.

Press CTRL+a or choose “Add to Project” in the “Files” menu.
Choose all the rest of the measurements in the open file dialog.
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Again, i-Star will take a moment to process the files and report on the 
“Data Layout” page. You will then return to the “Project Description” page.

Now that all the files in this project have been imported, we are ready to 
analyze the data. Before we analyze the data though, we should check the 
“Target Model” window. This window shows the visual representation of the 
imported data and must look exactly like the target used for collecting the 
data.

Press CTRL+t, or select “Target Model Window” in the “View” menu.

Fig. 14

The target window now shows the reference target, i.e. the  first page that 
was printed.  This window offers a number of controls, and they are all de-
scribed in the I-Star manual. The first control changes the file (and the corre-
sponding target) represented by the image on the screen.

Now that we’ve verified that all the data has been imported properly, we 
can close the target model window. Note that in some cases you might need to 
open the “Target Model” window much earlier - including but not limited to 
importing uncleanly defined data, data from non-native or multiple Spectro-
photometers and their corresponding applications.

Press g.
Close the “Target Model” window.
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Fig. 15

Fig. 16
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I-Star provides a number of charting options, including: spectral and hue 
angle distributions, I-Star component development and results, and tonal re-
production charts, as well as component Histograms. The chart window con-
sists of a single page containing two tabs: “Settings” and “Chart.” The “Chart” 
tab contains the chart itself, as well as a lower panel with controls for modi-
fying the parameters that appear in the chart. By right-clicking on anywhere 
on the lower panel, you can access the chart selection menu which contains 
various options for all the available charts. The “Settings” tab contains all the 
controls for the appearance of the charts. The individual group titles indicate 
the charts these settings refer to.

Press Ctrl + g
Navigate to the “Settings” tab.
In the I* Component Results and Averaged Parameter Development check 

the boxes for I*color full, I*tone full, I*Total, and Quality Control for both 
I*tone and I*color, as well as Brightness Factor full and Contrast Factor full.

Navigate to the “Chart” tab. Check the “Show legend” checkbox. 

Fig. 17
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Fig. 18

Your Charts window should now look like the chart above. The legend 
at the bottom of the chart shows you what each of the trend lines mean. By 
clicking on each of the data points the status bar shows the file this data point 
belongs to, as well as the point’s x and y coordinates on the chart.  

The definitions for each of the graphs can be found in the “i-star Glossary.
pdf” file that can be found on the i-star webpage. 

I-Star can also analyze this data for any chosen region of interest in the 
color space of the target. So, let us consider the region of skin tones as defined 
in the template.

Fig. 19
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 I-star has the ability to plot several types of graphs for all the regions of 
interest.  For this tutorial we will analyze the spectral distribution of a skin 
tone patch.

Right-click on the bottom section of the chart panel and select “Spectral 
Distribution” in the context menu.

Change the column value to 30 and the row value to 19.

Analysis of the graph shows a smoothening (straightening) of the spec-
tral distribution curve for the patch at row 30 column 19 as more pages are 
printed.  This indicates that the patch is turning neutral from its original skin 
tone color. In fact by page 270 (topmost red line) the spectral distribution is al-
most a horizontal line with a noticeable hump around 430nm (blue).  This was 
probably due to the fact that all the other colors in the printer were depleted 
except for the light cyan ink and hence the slight blue tint of the almost paper 
white patch.  If the test was continued to the depletion of the light cyan ink the 
red line would be a straight, horizontal line instead.

 Experiment with other row/column values and observe the spectral distri-
bution changes.

Finally, it’s important to save your project. This will allow you to later eas-
ily access your data without having to reenter all the data as previously done 
in this tutorial. It will save the complete set of data, a snapshot of the settings, 
as well as the results of all the calculations. Please note that i-Star will not 
save your open windows, as well as generated graphs, so you must export 
them before closing the windows.

As mentioned before, I-Star saves all project data entered in the applica-
tion. It is however recommended that you keep your original source files as 
well as periodically back up all your I-Star projects to prevent possible data 
loss.

Press CTRL+S or select “Save Project” in the “Project” menu.

Fig. 20
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A save file dialog will appear.

Choose a name under which you want to save the project for later refer-
ence

Click the “Save” button.
Continue exploring I-Star. Explanations on the remainder of the controls, 

including those for the main settings page are available in the User Manual 
for your reference.

When you’re done, press:
CTRL+Q or choose “Quit” in the “i-Star” menu. 

You will be prompted to save any additional changes to your currently 
open project.

Enjoy!


